The Autodesk Revit World

*I’m sure you’ve seen* plenty of presentations on how wonderful and versatile this 3D Autodesk® Revit® Architecture revolution is. You may be thinking, “This all seems too complicated for what I do. Why do I need 3D anyway?”

The answer is: you don’t need 3D. What do you do to get a job out—that is, after the presentation when you’re awarded the project? First, you redraw the plans. Next comes the detail round-up game we have all come to love: pull the specs together and then plot. This is a simple process that works.

Well, it worked until 3D showed up. Now we have no real clue where things come from, drawings don’t look very good, and getting a drawing out the door takes three times as long.

That’s the perception anyway. I’ve certainly seen all of this happen, but I’ve also seen some incredibly coordinated sets of drawings with almost textbook adherence to standards and graphics. Revit can go both ways—it depends on you to make it go the right way.

I’m sure you’ve heard about *building information modeling (BIM).* Although some say BIM is a process, not an application, I don’t fully buy into that position. Right now, you’re on the first page of BIM. BIM starts with Revit. If you understand Revit, you’ll understand building information modeling.

This chapter will dive into the Revit graphical user interface (GUI) and tackle the three topics that make Revit, well, Revit.

► The Revit interface

► The Project Browser

► File types and families
The Revit Interface

Toto, we aren’t in CAD anymore!

If you just bought this book, then welcome to the Revit world. In Revit, the vast majority of the processes you encounter are in a flat 2D platform. Instead of drafting, you’re placing components into a model. Yes, these components have a so-called third dimension to them, but a logical methodology drives the process. If you need to see the model in 3D, it’s simply a click away. That being said, remember this: there is a big difference between 3D drafting and modeling.

With that preamble behind us, let’s get on with it.

First, Revit has no command prompt and no crosshairs. Stop! Don’t go away just yet. You’ll get used to it, I promise. Unlike most CAD applications, Revit is heavily pared down, so to speak. It’s this way for a reason. Revit was designed for architects and engineers. You don’t need every command that a mechanical engineer would need. An electrical engineer wouldn’t need the functionality that an architect would require. In the Revit Architecture 2017 interface, the functionality I just mentioned is available, but it’s tucked away so as not to interfere with your architectural pursuits.

NOTE This book is designed to cut to the chase and show you how to use Revit Architecture in a step-by-step fashion without having to read through paragraph after paragraph of theory just to find the answer you’re seeking. Datasets are provided on the book’s accompanying website (www.sybex.com/go/revit2017ner), but you can also use your own model as you go through the book. If you don’t want to read this book cover to cover, don’t! Although I recommend going from front to back, you can use the book as a desk reference by jumping to a desired topic. The datasets will be added in phases to accommodate this type of usage. Either way, get ready to learn Revit!

You’ll find that, as you get comfortable with Revit, there are many, many choices and options behind each command.

1. To open Revit, click the icon on your desktop (see Figure 1.1).
2. After you start Revit, you'll see the Recent Files window, as shown in Figure 1.2. The top row shows any projects on which you've been working; the bottom row shows any families with which you've been working. The column to the right allows you to view some tutorial videos. If you have time, I recommend investigating this feature.

![Recent Files Window](image)

**Figure 1.2**: The Recent Files window shows any recent projects or families on which you've worked.

3. In the upper-left corner of the Revit window, you'll see a big blue R. This is commonly known as the Application icon. Click the blue R, and choose New ➔ Project.

4. The New Project dialog shown in Figure 1.3 opens. Click the Template File drop-down menu, and select Architectural Template. If you're a metric user, click the Browse button. This will open Windows Explorer. Go up one level, and choose the US Metric folder. Select the file called DefaultMetric.rte. If you cannot find this file, go to the book's accompanying website (www.sybex.com/go/revit2017ner) and download all files pertaining to the entire book, especially the files for Chapter 1.

Now that the task of physically opening the application is out of the way, you can delve into Revit. Revit has a certain feel that Autodesk® AutoCAD® converts (and MicroStation converts) will need to grasp. At first, if you're already a AutoCAD user, you'll notice many differences between Revit and AutoCAD. Some of these differences may be off-putting, while others will make you say, “I wish AutoCAD did that.” Either way, you'll have to adjust to a new workflow.
The Revit Workflow

This new workflow may be easy for some to adopt, whereas others will find it excruciatingly foreign. (To be honest, I found the latter to be the case at first.) Either way, it’s a simple concept. You just need to slow down a bit from your CAD habits. If you’re new to the entire modeling/drafting notion and you feel you’re going too slowly, don’t worry. You do a lot with each click of the mouse.

Executing a command in Revit is a three-step process.

1. At the top of the Revit window is the Ribbon, which contains a series of tabs. Each tab contains a panel. This Ribbon will be your Revit launch pad! Speaking of launch pads, click the Wall button on the Architecture tab, as shown in Figure 1.4.

2. After you click the Wall button, notice that Revit adds a tab to the Ribbon with additional choices specific to the command you’re running, as shown in Figure 1.5. You may also notice that Revit places an additional Options bar below the Ribbon for even more choices.

**FIGURE 1.3**: The New Project dialog allows you to start a new project using a preexisting template file, or you can create a new template file.

**FIGURE 1.4**: The Ribbon is the backbone of Revit.
3. After you make your choices from the Ribbon and the Options bar, you can place the object into the view window. This is the large drawing area that takes up two-thirds of the Revit interface. To place the wall, simply pick a point in the window and move your pointer in the direction that you want the wall to travel. The wall starts to form. Once you see that, you can press the Esc key to exit the command. (I just wanted to illustrate the behavior of Revit during a typical command.)

Using Revit isn’t always as easy as this, but just keep the following basic three-step process in mind and you’ll be OK:

1. Start a command.

2. Choose an option from the temporary tab or the Options bar that appears.

3. Place the item in the view window.

Thus, on the surface Revit appears to offer a fraction of the choices and functionality offered by AutoCAD (or any drafting program, for that matter). This is true in a way. Revit does offer fewer choices to start a command, but the choices that Revit does offer are much more robust and powerful.

Revit keeps its functionality focused on designing and constructing buildings. Revit gets its robust performance from the dynamic capabilities of the application during the placement of the items and the functionality of the objects after you place them in the model. You know what they say: never judge a book by its cover—unless, of course, it’s the book you’re reading right now.

Let’s keep going with the main focus of the Revit interface: the Ribbon. You’ll be leaning on the Ribbon extensively in Revit.

### Using the Ribbon

You’ll use the Ribbon for the majority of the commands you execute in Revit. As you can see, you have little choice but to do so. However, this is good because it narrows your attention to what is right in front of you.
When you click an icon on the Ribbon, Revit will react to that icon with a new tab, giving you the specific additional commands and options you need. Revit also keeps the existing tabs that can help you in the current command, as shown in Figure 1.6. Again, the focus is on keeping your eyes in one place.

![Ribbon Screenshot](image)

**FIGURE 1.6:** The Ribbon breakdown showing the panels

In this book, I’ll throw quite a few new terms at you, but you’ll get familiar with them quickly. I just discussed the Ribbon, but mostly you’ll be directed to choose a tab in the Ribbon and to find a panel on that tab.

To keep the example familiar, when you select the Wall button, your instructions will read: “On the Build panel of the Architecture tab, click the Wall button.”

### What’s That Toolbar Above the Ribbon?

This toolbar is called the *Quick Access toolbar*. I’m sure you’ve seen a similar toolbar in other applications. It comes filled with some popular commands. If you want to add commands to this toolbar, simply right-click any icon and select Add To Quick Access Toolbar. To the left of this toolbar is the Application icon. Clicking this icon gives you access to more Revit functions that will be covered later in the book. One great icon that I like to have docked on the Quick Access toolbar is the Select Objects (or Modify) icon. I like to add this icon as shown here:

![Quick Access Toolbar Screenshot](image)

Now that you can see how the Ribbon and the tabs flow together, let’s look at another feature in the Ribbon panels that allows you to reach beyond the immediate Revit interface.
The Properties Interface

When you click the Wall button, a new set of commands appears on the Ribbon. This new set of commands combines the basic Modify commands with a tab specific to your immediate process. In this case, that process is adding a wall.

You’ll also notice that the Properties dialog near the left of the screen changes, as shown in Figure 1.7. The Properties dialog shows a picture of the wall you’re about to place. If you click this picture, Revit displays all the walls that are available in the model. This display is called the Type Selector drop-down (see Figure 1.8).

**Figure 1.7:** Click the Properties button to display the Properties dialog. Typically, the dialog is shown by default.

The objective of the next exercise is to start placing walls into the model.

1. Close Revit by clicking the close button in the upper-right corner.
2. Reopen Revit, and start a new project using the Architectural template (Default.rvt) (Metric or Imperial).
3. On the Architecture tab, click the Wall button.
4. In the Properties dialog, select Exterior – Brick And CMU On MTL. Stud from the Type Selector. (Metric users, select Basic...
Wall – Exterior Brick On Mtl. Stud. This will look somewhat different throughout the book, but you get a break. It is slightly easier to work with than the Imperial wall type.)

**Figure 1.8**: The Properties dialog gives you access to many variables associated with the item you’re adding to the model.

**Element Properties**

There are two different sets of properties in Revit: instance properties and type properties. Instance properties are available immediately in the Properties dialog when you place or select an item. If you make a change to an element property, the only items that are affected in the model are the items you’ve selected.

**The Properties Dialog**

As just mentioned, the Properties dialog displays the instance properties of the item you’ve selected. If no item is selected, this dialog displays the properties of the current view in which you happen to be.
You also have the ability to combine the Properties dialog with the adjacent dialog, which is called the Project Browser (you’ll examine the Project Browser shortly). Simply click the top of the Properties dialog, as shown in Figure 1.9, and drag it onto the Project Browser. Once you do this, you’ll see a tab that contains the properties and a tab that contains the Project Browser (also shown in Figure 1.9).

![Dragging the Properties dialog onto the Project Browser](image)

**FIGURE 1.9**: Dragging the Properties dialog onto the Project Browser

Let’s take a closer look at the two categories of element properties in Revit.

**Instance Properties**

The items that you can edit immediately are called *parameters* or *instance properties*. These parameters change only the object being added to the model at this time. Also, if you select an item that has already been placed in the model, the parameters you see immediately in the Instance Properties dialog change only that item you’ve selected. This makes sense—not all items are built equally in the real world. Figure 1.10 illustrates the instance properties of a typical wall.
Type Properties

*Type properties* (see Figure 1.11), when edited, alter every item of that type in the entire model. To access the type properties, click the Edit Type button in the Properties dialog, as Figure 1.12 shows.

At this point, you have two choices. You can make a new wall type (leaving this specific wall unmodified) by clicking the Duplicate button at the upper right of the dialog, or you can start editing the wall’s type properties, as shown in Figure 1.13.

![Properties dialog](image)

**Figure 1.10:** The instance properties change only the currently placed item or the currently selected item.

**Warning**  I can’t stress enough that if you start modifying type properties without duplicating the type, you need to do so in a very deliberate manner. You can easily affect the model in unintended ways. We’ll discuss the specifics of all the wall’s type properties in Chapter 15, “Advanced Wall Topics.”
The type properties, when modified, alter every occurrence of this specific wall in the entire model.

The Edit Type button allows you to access the type properties.
Now that you’ve gained experience with the Type Properties dialog, it’s time to go back and study the Options bar as it pertains to placing a wall.

1. Because you’re only exploring the element properties, click the Cancel button to return to the model.

2. Back in the Options bar, find the Location Line menu. Through this menu, you can set the wall justification. Select Finish Face: Exterior (see Figure 1.14).

3. On the Options bar, be sure the Chain check box is selected, as Figure 1.14 shows. This will allow you to draw the walls continuously.

4. The Draw panel has a series of sketch options. Because this specific wall is straight, make sure the Line button is selected, as shown in Figure 1.15.

Get used to studying the Ribbon and the Options bar—they will be your crutch as you start using Revit! Of course, at some point you need to begin placing items physically in the model. This is where the view window comes into play.
Figure 1.14: By selecting Finish Face: Exterior, you know the wall will be dimensioned from the outside finish.

Figure 1.15: You can draw any shape you need.

The View Window

To put it simply, the big white area where the objects go is the view window. As a result of your actions, this area will become populated with your model. Notice that the background is white—this is because the sheets you plot on are white. In Revit, what you see is what you get … literally. Line weights in Revit are driven by the object, not by the layer. In Revit, you aren’t counting on color #5, which is blue, for example, to be a specific line width when you plot. You can immediately see the thickness that all your lines will be before you plot (see Figure 1.16). What a novel idea.
WARNING Metric users should not type in mm or other metric abbreviations when entering amounts suggested in the exercises. Revit won’t accept such abbreviations. Simply enter the number provided within the parentheses.

To continue placing some walls in the model, keep going with the exercise. (If you haven’t been following along, you can start by clicking the Wall button on the Architecture tab. In the Properties dialog box, select Exterior – Brick And CMU On MTL. Stud (or Basic Wall – Exterior Brick On Mtl. Stud for metric users). Make sure the wall is justified to the finish face exterior.) You may now proceed.

1. With the Wall command still running and the correct wall type selected, position your cursor in a location similar to the illustration in Figure 1.17. Pick a point in the view window.
2. With the first point picked, move your cursor to the left. Notice that two things happen: the wall seems to snap in a horizontal plane, and a blue dashed line locks the horizontal position. In Revit, there is no Ortho. Revit aligns the typical compass increments to 0°, 90°, 180°, 270°, and 45°.

3. Also notice the blue dimension extending from the first point to the last point. Although dimensions can’t be typed over, this type of dimension is a temporary dimension for you to use as you place items. Type 100’ (30000 mm), and press the Enter key. Notice that you didn’t need to type the foot mark (’) or mm. Revit thinks in terms of feet or millimeters. The wall is now 100’ (30000 mm) long (see Figure 1.17).

4. With the Wall command still running, move your cursor straight up from the endpoint of your 100’-long wall. Look at Figure 1.18.

5. Type 80’ (24000 mm), and press Enter. You now have two walls.

6. Move your cursor to the right until you run into another blue alignment line. Notice that your temporary dimension says 100’–0” (30000.0). Revit understands symmetry. After you see this alignment line and the temporary dimension says 100’–0” (30000.0), pick this point.
1. Move your cursor straight down, type 16' (4800 mm), and press Enter.

2. Move your cursor to the right, type 16' (4800 mm), and press Enter.

3. Press the Esc key twice.

Do your walls look like Figure 1.19? If not, try it again. You need to be comfortable with this procedure (as much as possible).

Figure 1.18: How Revit Architecture works is evident in this procedure.

Figure 1.19: Working with Revit starts with the ability to work with the view window and learn the quirks and feel of the interface.
To get used to the Revit flow, always remember these three steps:

1. Start a command.
2. Focus on your options.
3. Move to the view window, and add the elements to the model.

If you start a command and then focus immediately on the view, you’ll be sitting there wondering what to do next. Don’t forget to check your Options bar and the appropriate Ribbon tab.

Let’s keep going and close this building by using a few familiar commands. If you’ve never drafted on a computer before, don’t worry. These commands are simple. The easiest but most important topic is how to select an object.

**Object Selection**

Revit has a few similarities to AutoCAD and MicroStation. One of those similarities is the ability to perform simple object selection and to execute common modify commands. For this example, you’ll mirror the two 16’–0” (4800 mm) L-shaped walls to the bottom of the building:

1. Type ZA (zoom all).
2. Near the two 16’–0” (4800 mm) L-shaped walls, pick (left-click) and hold down the left mouse button when the cursor is at a point to the right of the walls but above the long, 100’–0” (30000 mm) horizontal wall.
3. You see a window start to form. Run that selection window down and to the left past the two walls. After you highlight the walls, as shown in Figure 1.20, let go of the mouse button, and you’ve selected the walls.

![Figure 1.20: Using a crossing window to select two walls](image)
There are two ways to select an object: by using a crossing window or by using a box. Each approach plays an important role in how you select items in a model.

**Crossing Windows**

A *crossing window* is an object-selection method in which you select objects by placing a window that crosses through the objects. A crossing window always starts from the right and ends to the left. When you place a crossing window, it’s represented by a dashed-line composition (as you saw in Figure 1.20).

**Boxes**

With a box object-selection method, you select only items that are 100 percent inside the window you place. This method is useful when you want to select specific items while passing through larger objects that you may not want in the selection set. A box always starts from the left and works to the right. The line type for a selection window is a continuous line (see Figure 1.21).

Now that you have experience selecting items, you can execute some basic modify commands. Let’s begin with mirroring, one of the most popular modify commands.
Modifying and Mirroring

Revit Architecture allows you either to select the item first and then execute the command or to start the command and then select the objects to be modified. This is true for most action items and is certainly true for every command on the Modify toolbar.

1. Make sure only the two 16’–0” (4800 mm) walls are selected.

2. When the walls are selected, the Modify | Walls tab appears. On the Modify panel, click the Mirror – Draw Axis button, as shown in Figure 1.22.

3. Your cursor changes to a crosshair with the mirror icon, illustrating that you’re ready to draw a mirror plane.

4. Make sure the Copy check box is selected (see Figure 1.23).

5. Hover your cursor over the inside face of the 80’–0” (24000 mm) vertical wall until you reach the midpoint. Revit displays a triangular icon, indicating that you’ve found the midpoint of the wall (see Figure 1.24).
6. When the triangular midpoint snap appears, pick this point. After you pick the point where the triangle appears, you can move your cursor directly to the right of the wall. An alignment line appears, as shown in Figure 1.25. When it does, you can pick another point along the path. When you pick the second point, the walls are mirrored and joined with the south wall (see Figure 1.26).
Now that you have some experience mirroring items, it’s time to start adding components to your model by using the items that you placed earlier. If you’re having trouble following the process, retry these first few procedures. Rome wasn’t built in a day. (Well, perhaps if they’d had Revit, it would have sped things up!) You want your first few walls to look like Figure 1.26.

**Building on Existing Geometry**

You have some geometry with which to work, and you have some objects placed in your model. Now Revit starts to come alive. The benefits of using building information modeling will become apparent quickly, as explained later in this chapter. For example, because Revit knows that walls are walls, you can add identical geometry to the model by simply selecting an item and telling Revit to create a similar item.

Suppose you want a radial wall of the same type as the other walls in the model. Perform the following steps:

1. Type ZA to zoom the entire screen.
2. Press the Esc key.
3. Select one of the walls in the model—it doesn’t matter which one.
4. Right-click the wall.
5. Select Create Similar, as shown in Figure 1.27.
6. On the Modify | Place Wall tab, click the Start-End-Radius Arc button, as shown in Figure 1.28.

**Figure 1.27:** You can select any item in Revit and create a similar object by right-clicking and selecting Create Similar.

**Figure 1.28:** Just because you started the command from the view window doesn’t mean you can ignore your options.

**Note** When you right-click an item, you can choose to repeat the last command. You can also select all items that are only in the current view or in the entire project.
7. Again with the options? Yes. Make sure Location Line is set to Finish Face: Exterior (it should be so already).

8. With the wheel button on your mouse, zoom into the upper corner of the building and select the top endpoint of the wall, as shown in Figure 1.29. The point you’re picking is the corner of the heavy lines. The topmost, thinner line represents a concrete belt course below. If you’re having trouble picking the correct point, don’t be afraid to zoom into the area by scrolling the mouse wheel. (Metric users do not have the concrete belt. Just pick the outside heavy line representing the brick face.)

9. Select the opposite, outside corner of the bottom wall. Again, to be more accurate you’ll probably have to zoom into each point as you’re making your picks.

![Figure 1.29](image_url): Select the top corner of the wall to start your new radial wall.

10. Move your cursor to the right until you see the curved wall pause. You’ll see an alignment line and possibly a tangent snap icon appear as well. Revit understands that you may want an arc tangent on the two lines you’ve already placed in your model.

11. When you see the tangent snap icon, choose the third point. Your walls should look like Figure 1.30.
Just because you've placed a wall in the model doesn't mean the wall looks the way you would like it to appear. In Revit, you can do a lot with view control and how objects are displayed.

**View Control and Object Display**

Although the earlier procedures are a nice way to add walls to a drawing, they don't reflect the detail you'll need to produce construction documents. The great thing about Revit, though, is that you've already done everything you need to do. You can now tell Revit to display the graphics the way you want to see them.

**The View Control Bar**

At the bottom of the view window, you'll see a skinny toolbar (as shown in Figure 1.31). This is the View Control bar.

**Figure 1.31:** The View Control bar controls the graphical view of your model.

It contains the functions outlined in the following list:

**Scale** The first item on the View Control bar is the Scale function. It gets small mention here, but it's a huge deal. In Revit, you change the scale of a view by selecting this menu. Change the scale here, and Revit will scale annotations and symbols accordingly (see Figure 1.32).
The Detail Level allows you to view your model at different qualities. You have three levels to choose from: Coarse, Medium, and Fine (see Figure 1.33).

If you want more graphical information with this view, select Fine. To see how the view is adjusted using this control, follow these steps:

1. Click the Detail Level icon, and choose Fine.
2. Zoom in on a wall corner. Notice that the wall components are now showing in the view.
Tip When you change the view control in a view, it isn't a temporary display. You're telling Revit how you want to plot this view. The view you see on the screen is the view you’ll see when it comes out of the plotter.

There are other items on the View Control bar, but I'll discuss them when they become applicable to the exercises.

The View Tab

Because Revit is one big happy model, you’ll quickly find that simply viewing the model is quite important. In Revit, you can take advantage of some functionality in the Navigation bar. To activate the Navigation bar, first go to the View tab, and click the User Interface button. Then go to the default 3D view, and make sure the Navigation bar is activated, as shown in Figure 1.34.

Figure 1.34: The View tab allows you to turn on and off the Navigation bar.

One item you need to look at on the Navigation bar is the steering wheel.

The Steering Wheel

The steering wheel allows you to zoom, rewind, and pan. When you click the steering wheel icon, a larger control panel appears in the view window. To choose one of the options, you simply pick (left-click) one of the options and hold down the mouse button as you execute the maneuver.
To use the steering wheel, follow these steps:

1. Go back to Floor Plan Level 1, and pick the steering wheel icon from the Navigation bar.

2. When the steering wheel is in the view window (as shown in Figure 1.35), left-click and hold Zoom. You can now zoom in and out.

![Figure 1.35: You can use the steering wheel to navigate through a view.](image)

3. Click and hold Rewind in the steering wheel. You can now find an older view, as shown in Figure 1.36.

![Figure 1.36: Because Revit doesn’t include zoom commands in the Undo function, you can rewind to find previous views.](image)

4. Do the same for Pan, which is on the outer ring of the steering wheel. After you click and hold Pan, you can navigate to other parts of the model.

Although you can do all this with your wheel button, some users still prefer the icon method of panning and zooming. For those of you who prefer the icons, you’ll want to use the icons for the traditional zooms as well.

When you’re finished using the steering wheel, press Shift+W or Exit to close out.
Traditional Zooms

The next items on the Navigation bar are the good-old zoom controls. The abilities to zoom in, zoom out, and pan are all included in this function, as shown in Figure 1.37.

![Zoom commands](image)

**Figure 1.37:** The standard zoom commands

Of course, if you have a mouse with a wheel, you can zoom and pan by either holding down the wheel to pan or wheeling the button to scroll in and out.

Thin Lines

Back on the View tab, you'll see an icon called Thin Lines, as shown in Figure 1.38. Let's talk about what this icon does.

![Thin Lines icon](image)

**Figure 1.38:** Clicking the Thin Lines icon lets you operate on the finer items in a model.

In Revit Architecture, there are no layers. Line weights are controlled by the actual objects they represent. In the view window, you see these line weights. As mentioned, what you see is what you get.
Sometimes, however, these line weights may be too thick for smaller-scale views. By clicking the Thin Lines icon, as shown in Figure 1.38, you can force the view to display only the thinnest lines possible and still see the objects.

To practice using the Thin Lines function, follow these steps:

1. Pick the Thin Lines icon.
2. Zoom in on the upper-right corner of the building.
3. Pick the Thin Lines icon again. This toggles the mode back and forth.
4. Notice that the lines are heavy.

The line weight should concern you. As mentioned earlier, there are no layers in Revit Architecture. This topic is addressed in Chapter 12, “Creating Specific Views and Match Lines.”

**3D View**

The 3D View icon brings us to a new conversation. Complete the following steps, which will move us into the discussion of how a Revit model comes together:

1. Click the 3D View icon, as shown in Figure 1.39.

![Figure 1.39: The 3D View icon will be used heavily.](image)

2. On the View Control bar, click the Visual Style button and choose Realistic, as shown in Figure 1.40.

![Figure 1.40: The Visual Style button enables you to view your model in color. This is typical for a 3D view.](image)
3. Again on the View Control bar, select the Shadows On icon and turn on shadows, as shown in Figure 1.41.

![Figure 1.41: Shadows create a nice effect but at the expense of RAM.]

**Figure 1.41:** Shadows create a nice effect but at the expense of RAM.

**Warning:** If you turn on shadows, do so with care. This could be the single worst item in Revit in terms of performance degradation. Your model will slow down with shadows on.

Within the 3D view is the ViewCube. It's the cube in the upper-right corner of the view window. You can switch to different perspectives of the model by clicking the quadrants of the cube (see Figure 1.42).

![Figure 1.42: The ViewCube lets you look freely at different sides of the building.]

**Figure 1.42:** The ViewCube lets you look freely at different sides of the building.

**Tip:** The best way to navigate a 3D view is to press and hold the Shift key on the keyboard. As you're holding the Shift key, press and hold the wheel on your mouse. Now move the mouse around. You'll be able to view the model dynamically.

Your model should look similar to Figure 1.43. (Metric users, you do not have the concrete belt or the concrete block coursing below the brick.)

![Figure 1.43: The model with shadows turned on]

**Figure 1.43:** The model with shadows turned on
The Project Browser

Go back to the floor plan. Wait! How? This brings us to an important topic in Revit: the Project Browser.

**Lock It Up!**

If you’re happy with this view and you don’t want to screw it up inadvertently, you can lock the orientation of the view as shown here. This is an important thing to know because, as you start creating sheets, you’ll sometimes find that the 3D view you’re randomly spinning around is actually on a sheet. For this lesson, leave the view unlocked.

The Project Browser

Revit is the frontrunner of BIM. BIM has swept our industry for many reasons. One of the biggest reasons is that you have a fully integrated model in front of you. That is, when you need to open a different floor plan, elevation, detail, drawing sheet, or 3D view, you can find it all right there in the model.

Also, this means your workflow will change drastically. When you think about all the external references and convoluted folder structures that make up a typical job, you can start to relate to the way Revit uses the Project Browser. In Revit, you use the Project Browser instead of the folder structure you used previously in CAD.

This approach changes the playing field. The process of closing the file you’re in and opening the files in which you need to do work is restructured in Revit to enable you to stay in the model. You never have to leave one file to open another. You also never need to rely on external referencing to complete a set of drawings. Revit and the Project Browser put it all in front of you.

To start using the Project Browser, follow these steps:

1. To the far left of the Revit interface are the combined Project Browser and Properties dialogs. At the bottom of the dialogs, you’ll see two tabs, as shown in Figure 1.44. Click the Project Browser tab.
2. The Project Browser is broken down into categories. The first category is Views. The first View category is Floor Plans. In the Floor Plans category, double-click Level 1.

3. Double-click Level 2. Notice that the walls look different than in Level 1. Your display level is set to Coarse. This is because any change you make on the View Control bar is for that view only. When you went to Level 2 for the first time, the change to the display level had not yet been made.

4. In the view window, you see little icons that look like houses (see Figure 1.45). These are elevation markers. (Metric users, yours are round.) The elevation marker to the right might be in your building or overlapping one of the walls. If this is the case, you need to move it out of the way.
5. Pick a box around the elevation marker. When both the small triangle and the small box are selected, move your mouse cursor over the selected objects.

6. Your cursor turns into a move icon. Pick a point on the screen, and move the elevation marker out of the way.

7. In the Project Browser, find the Elevations (Building Elevation) category. Double-click South.

8. Also in the Project Browser, notice the 3D Views category. Expand the 3D Views category, and double-click the (3D) choice. This brings you back to the 3D view you were looking at before this exercise.

Now that you can navigate through the Project Browser, adding other components to the model will be much easier. Next, you’ll begin to add some windows.

**WARNING**  “Hey! What happened to my elevation?” You’re in Revit now. Items such as elevation markers, section markers, and callouts are no longer just dumb blocks: they’re linked to the actual view they’re calling out. If you delete one of these markers, you’ll delete the view associated with it. If you and your design team have been working on that view, then you’ve lost that view. Also, you must move any item deliberately and with caution. The elevation marker you moved in the previous exercise has two parts: the little triangle is the elevation, and the little box is the part of the marker that records the sheet number on which the elevation will wind up. If you don’t move both items together by placing a window around them, the elevation’s origin will remain in its original position. When this happens, your elevation will look like a section, and it will be hard to determine how the section occurred.

**Windows**

By clicking all these views, you’re simply opening a view (window) of the building, not another file that is stored somewhere. For some users, this can be confusing. (It was initially for me.)
When you click around and open views, they stay open. You can quickly open many views. There is a way to manage these views before they get out of hand.

In the upper-right corner of the Revit dialog, you’ll see the traditional close and minimize/maximize buttons for the application. Just below them are the traditional buttons for the files that are open, as shown in Figure 1.46. Click the X to close the current view.

![Figure 1.46](image)

**Figure 1.46:** You can close a view by clicking the X for the view. This doesn’t close Revit (or an actual file for that matter); it simply closes that view.

In this case, you have multiple views open. This situation (which is quite common) is best managed on the View tab. To use the Window menu, perform the following steps:

1. On the Windows panel of the View tab, click the Switch Windows button, as shown in Figure 1.47.

![Figure 1.47](image)

**Figure 1.47:** The Switch Windows menu lists all the current views that are open.

2. After the menu is expanded, look at the open views.

3. Go to the {3D} view by selecting it from the Window menu and clicking the 3D icon at the top of the screen or by going to the {3D} view in the Project Browser.


5. In the Project Browser, open Level 1.

6. Go to the Windows panel, and select Tile Windows.
7. With the windows tiled, you can see the Level 1 floor plan along with the 3D view to the side. Select one of the walls in the Level 1 floor plan. Notice that it’s now selected in the 3D view. The views you have open are mere representations of the model from that perspective. Each view of the model can have its own independent view settings.

8. Click into each view, and type ZA. Doing so zooms the extents of each window. This is a useful habit to get into.

You’re at a safe point now to save the file. This also brings us to a logical place at which to discuss the various file types and their associations with the BIM model.

**But I Used to Type My Commands!**

You can still type your commands. In the Revit menus, you may have noticed that many of the menu items have a two- or three-letter abbreviation to the right. This is the keyboard shortcut associated with the command. You can make your own shortcuts, or you can modify existing keyboard shortcuts—if you navigate to the View tab. On the Windows panel, click the User Interface button. In the drop-down menu, click the Keyboard Shortcuts button. Here you can add or modify keyboard shortcuts.
File Types and Families

Revit Architecture has a unique way of saving files and using different file types to build a BIM model. To learn how and why Revit has chosen these methods, follow these steps:

1. Click the Save icon (see Figure 1.48).

   ![Figure 1.48](image)
   
   **Figure 1.48**: The traditional Save icon brings up the Save As dialog if the file has never been saved.

2. In the Save As dialog, click the Options button in the lower-right corner (see Figure 1.49).

   ![Figure 1.49](image)
   
   **Figure 1.49**: The Options button in the Save As dialog lets you choose how the file is saved.

3. In the File Save Options dialog is a place at the top where you can specify the number of backups, as shown in Figure 1.50. Set this value to 1.

   Revit provides this option because when you click the Save icon, Revit duplicates the file. It adds a suffix of 0001 to the end of the filename. Each time you click the Save icon, Revit records this save and adds another file called 0002, leaving the 0001 file intact. The default is to do this three times before Revit starts replacing 0001, 0002, and 0003 with the three most current files.
4. In the Preview section, you can specify in which view this file will be previewed. I like to keep it as the active view. That way I can get an idea of whether the file is up to date based on the state of the view. Click OK.

5. Create a folder somewhere, and save this file into the folder. The name of the file used as an example in the book is _NER.rvt_. (NER stands for “No Experience Required.”) Of course, you can name the file anything you want, or you can even make your own project using the steps and examples from the book as guidelines.

Now that you have experience adding components to the model, it’s time to investigate exactly what you’re adding here. Each component is a member of what Revit calls a _family_.

**System and Hosted Families (.rfa)**

A Revit model is based on a compilation of items called families. There are two types of families: system families and hosted families. A _system family_ can be found only in a Revit model and can’t be stored in a separate location. A _hosted family_ is inserted similarly to a block (or cell) and is stored in an external directory. The file extension for a hosted family is _rfa_.

---

**Figure 1.50**: The options in the File Save Options dialog box let you specify the number of backups and the view for the preview.
System Families

System families are inherent to the current model and aren’t inserted in the traditional sense. You can modify a system family only through its element properties in the model. The walls you’ve put in up to this point are system families, for example. You didn’t have to insert a separate file to find the wall type. The system families in a Revit Architecture model are as follows:

- Walls
- Floors
- Roofs
- Ceilings
- Stairs
- Ramps
- Shafts
- Rooms
- Schedules/quantity takeoffs
- Text
- Dimensions
- Views

System families define your model. As you can see, the list pretty much covers most building elements. There are, however, many more components not included in this list. These items, which can be loaded into your model, are called hosted families.

Hosted Families

All other families in Revit are hosted in some way by a system family, a level, or a reference plane. For example, a wall sconce is a hosted family in that, when you insert it, it’s appended to a wall. Hosted families carry a file extension of .rfa.

To insert a hosted family into a model, follow these steps:

1. Open the NER-01.rvt file or your own file.
2. Go to Level 1.
3. On the Architecture tab, click the Door button.
4. On the Modify | Place Door tab, click the Load Family button, as shown in Figure 1.51. This opens the Load Family dialog.

![Figure 1.51: You can load an .rfa file during the placement of a hosted family.]

5. Browse to the Doors directory.
   Note that if you're on a network, your directories may not be the same as in this book. Contact your CAD/BIM manager (or whoever loaded Revit onto your computer) to find out exactly where they may have mapped Revit.

6. Notice that there is a list of doors. Select Single-Raised Panel with Sidelights.rfa, and click Open. (Metric users select M_Double-Panel 2.rfa.)

7. In the Properties dialog, click the Type Selector, as shown in Figure 1.52. Notice that in addition to bringing in the door family, you have seven different types of the door. These types are simply variations of the same door. You no longer have to explode a block and modify it to fit in your wall.

8. Select Single-Flush 36” × 84” (915 mm × 2134 mm), as shown in Figure 1.52.

9. Zoom in on the upper-left corner of the building, as shown in Figure 1.53.

10. To insert the door into the model, you must place it in the wall. (Notice that before you hover your cursor over the actual wall, Revit won't allow you to add the door to the model, as shown in Figure 1.53.) When your pointer is directly on top of the wall, you see the outline of the door. Pick a point in the wall, and the door is inserted. (I'll cover this in depth in the next chapter.)

11. Delete the door you just placed by selecting it and pressing the Delete key on your keyboard. This is just practice for the next chapter.
Each family .rfa file contains multiple types associated with that family.

You’ll use this method of inserting a hosted family into a model quite a bit in this book and on a daily basis when you use Revit. Note that when a family is loaded into Revit Architecture, there is no live path back to the file that was loaded. After it’s added to the Revit model, it becomes part of that model. To view a list of the families in the Revit model, go to the Project Browser and look for the Families category. There you’ll see a list of the families and their types, as Figure 1.54 shows.
The two main Revit file types have been addressed. Two others are also crucial to the development of a Revit model.

**Using Revit Template Files (.rte)**

The `.rte` extension pertains to a Revit template file. Your company surely has developed a template for its own standards or will do so soon. An `.rte` file is simply the default template that has all of your company’s standards built into it. When you start a project, you’ll use this file. To see how an `.rte` file is used, follow these steps:

1. Click the Application button, and select New ➤ Project.
2. In the resulting dialog, shown in Figure 1.55, click the Browse button.
3. Browsing throws you into a category with several other templates. You can now choose a different template.
4. Click Cancel twice.
Whenever you start a project, you’ll use the .rte template. When you start a new family, however, you’ll want to use an .rft file.

**Using Revit Family Files (.rft)**

The .rft extension is another type of template—only this one pertains to a family. It would be nice if Revit had every family fully developed to suit your needs. Alas, it doesn’t. You’ll have to develop your own families, starting with a family template. To see how to access a family template, perform these steps:

1. Click the Application button, and select New ➤ Family to open the browse dialog shown in Figure 1.56.

![Figure 1.56: The creation of a family starts with templates.](image-url)
2. Browse through these templates. You’ll most certainly use many of them.

3. Click the Cancel button.

Tempting? I know! I’ll cover creating families thoroughly in Chapter 16, “Creating Families.” As mentioned earlier, you’ll reach a certain point when you run out of Revit-provided content. If you’re feeling brave, go ahead and play around in one of the templates. You have nothing to lose (except time).

Are You Experienced?

Now you can...

✔ navigate the Revit Architecture interface and start a model

✔ find commands on the Ribbon and understand how this controls your options

✔ find where to change a keyboard shortcut to make it similar to CAD

✔ navigate through the Project Browser

✔ understand how the Revit interface is broken down into views

✔ tell the difference between the two different types of families and understand how to build a model using them